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1 Welcome 

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that 

can be used to monitor and control assets in space or on the ground.   

 

The TReK CFDP application provides the capability to transfer files using the 

Consultative Committee for Space Data Systems (CCSDS) File Delivery Protocol 

(CFDP). 

 

1.1 Getting Started 

Start with the Introduction which provides an application overview.  Next, try the Quick 

Start Guides for “How Tos” for common functions.  For help with details, reference the 

Details section.  See the FAQ and Troubleshooting section for helpful hints and solutions 

to the common “gotchas”. 

 

 

1.2 System Requirements 

Windows 7, Red Hat Enterprise Linux 6.x. 

 

 

2 Technical Support 

If you are having trouble installing the TReK software or using any of the TReK software 

applications, please try the following suggestions: 

 

Read the corresponding material in the manual and/or on-line help. 

 

Ensure that you are correctly following all instructions. 

 

Checkout the TReK Web site at http://trek.msfc.nasa.gov/ for Frequently Asked 

Questions. 

 

If you are still unable to resolve your difficulty, please contact us for technical assistance: 

 

TReK Help Desk E-Mail, Phone & Fax: 

 

E-Mail:  trek.help@nasa.gov 

Telephone:  256-544-3521 (7:00 a.m. - 3:30 p.m. Central Time) 

Fax:   256-544-9353 

 

TReK Help Desk hours are 7:00 a.m. – 3:30 p.m. Central Time Monday through Friday.  

If you call the TReK Help Desk and you get a recording please leave a message and 

someone will return your call.  E-mail is the preferred contact method for help.  The e-
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mail message is automatically forwarded to the TReK developers and helps cut the 

response time. 

 

 

3 Introduction 

The TReK CFDP application provides the capability to transfer files using the 

Consultative Committee for Space Data Systems (CCSDS) File Delivery Protocol 

(CFDP).   

 

The CCSDS File Delivery Protocol (CFDP) was developed by the Consultative 

Committee for Space Data Systems (CCSDS).  Official specifications are contained in a 

CCSDS document called the CFDP Blue Book (available at www.ccsds.org).  The CFDP 

protocol provides reliable transfer of files from one computer to another, and has been 

designed to work well over space links.  It can be used to perform space to ground, 

ground to space, space to space, and ground to ground file transfers.  The underlying 

communications protocol used by the TReK CFDP application is the User Datagram 

Protocol (UDP). 

 

CFDP requires a sender and a receiver.  The sender and receiver must be configured and 

running at the same time to perform a file transfer.  Each party is referred to as an 

“Entity”.  The sender is an entity and the receiver is an entity.  Each “Entity” must have a 

unique Entity ID.   For example:   

 

 

Figure 1 CFDP Sender and Receiver 

 

To move a file from one computer to another, you will enter one or more CFDP 

Commands (primitives) to indicate the action to be taken.  The syntax of a primitive is as 

follows: 

 

[CFDP Directive] [Class of Service] [source-path] [remote-EID] [destination-path] 

 

Example:  put class2 D:\file1.txt 2 /home/kirk/file1.txt 

 

The TReK CFDP application currently supports two CFDP Directives:  put and get.  

These are defined as follows: 

 

Put:  To copy one file from the local entity to the remote entity. 

Get:  To copy one file from the remote entity to the local entity. 

 

The file you want to transfer is considered the “Source” and the location it should be 

transferred to is considered the “Destination”. 

http://www.ccsds.org/
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Don’t worry there is no need to type in CFDP Commands unless you want to.  You can 

use drag and drop to build your CFDP Command list. 

 

Note:  The Get directive is not supported in all ISS CFDP implementations.  It is 

supported by TReK when both the sender and receiver are TReK CFDP implementations 

(TReK CFDP application, TReK CFDP console application, or TReK CFDP Library). 

 

In addition to this application, TReK also includes a CFDP console application and a 

CFDP library.  If you need CFDP functionality onboard a spacecraft consider the TReK 

CFDP console application.  If you need to include CFDP functionality in your own 

application, consider the TReK CFDP library.  The TReK CFDP library can be used to 

include CFDP functionality in a ground or flight application. 

  

4 Overview of the User Interface 

4.1 Main Window 

The main window contains several areas as shown in Figure 2.  Each area is a dock 

window that you can float or dock.  To float a dock window, use your left mouse button 

to click and hold the title area while dragging the window to another area of the screen.  

To dock, use the title bar to drag the dock window over the main window and drop. 

 

 

Figure 2 Main Window 

Toolbar 
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The toolbar at the top of the window provides quick access to configure the application 

and start and stop the CFDP service.  

 

CFDP Commands 

The CFDP Commands area provides a way to add and execute one or more CFDP 

commands (primitives).  Add a “put” command to send a file to a remote entity.  Add a 

“get” command to retrieve a file from a remote entity.  The “Show Directory” button 

provides access to the local file system.  Files can be dragged from this view of the local 

file system or from a file explorer window.   Files can also be added by pushing the Add 

Row button and typing in the file transfer information.  To delete a file from the list put 

your cursor in the row you would like to delete and push the Remove Row button.  To 

delete all files in the list push the Clear All button.  The Export List button provides a 

way to save the list of CFDP Commands in a file.  The Import List button provides a way 

to load a list of CFDP Commands from a file.  Each CFDP command entered into the list 

must include a Directive (put or get), the Class of Service (class1 or class2), the absolute 

path of the source file, the Remote Entity ID (Remote EID), and the absolute path of the 

destination file.  The Class of Service default is class2.  To execute all the CFDP 

commands (puts and gets) in the list, push the Execute All button.  After you push the 

Execute All button, the Restore All button can be used to restore the list of commands.  

The Restore All button will only restore the list of CFDP commands previously sent by 

pushing the Execute All button.  The Default Destination menu can be used to identify a 

default destination.  This can save typing when dragging and dropping files into the list.  

If the Default Destination is set, the destination selected will automatically be copied into 

the Destination field when a file is dropped into the list.  The Default Destination menu 

can be populated using the Configure dialog.   

 

Note:  You can enter the absolute path for a directory in the Source and Destination 

fields.  All the files in the first level of the directory will be transferred.  Subdirectories 

will not be transferred.  Each file in the directory will result in the execution of an 

individual CFDP Command (primitive).  Therefore, the transactions area will contain 

transaction information for each file transferred. 

 

Note 2:  There are two types of files supported by the CFDP application: the CFDP 

Application Configuration File and the CFDP Commands List file.  File/Save/Save As 

can be used to save an Application Configuration File.  The File/Open command provides 

a way to open an Application Configuration File.  The Export List button provides a way 

to save a CFDP Commands List file.  The Import List button provides a way to load a 

CFDP Commands List file.   

 

Transactions 

The Transactions area displays file transfer activity as it is in progress.  The Configure 

button displays the Configure dialog which provides a way to show and hide columns and 

rearrange the order of the columns.  To Clear, Pause, Resume, or Cancel one or more 

transactions, select the transactions in the list and push the desired button.   

 

Message Area 
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The Message Area displays important status and error messages.  The message area can 

be cleared using the View menu. 

 

 

4.2 Toolbar 

The toolbar provides visual information about the state of the application and provides 

access to common application functions.   

 

Configuration Status 

When the Configuration status is black, this indicates the application has not been 

configured.  When the Configuration status is green, this indicates the application has 

been configured and the CFDP service can be activated.   

 

Use the Configure button to access the Configuration dialog to configure the application. 

 

Operational Status 

When the Operational status is black, this indicates the CFDP service is inactive.  When 

the Operational status is green, this indicates the CFDP service is active and file transfer 

is supported.  The application must be properly configured before the Activate button will 

be available.  The CFDP service must be active before the Deactivate button will be 

available. 

 

Use the Activate button to activate the CFDP service.  This will initiate all internal 

activities needed to prepare the application to send and receive files.  When you activate 

the CFDP service, you will see activation status messages in the main window message 

area.   If you need to reconfigure the CFDP application, deactivate the CFDP service, and 

then push the Configure button to reconfigure. 

 

 

4.3 Menus 

The CFDP application menus are:  File, View, CFDP, Options, and Help.  Each of these 

menus is described in more detail below. 

 

File Menu 

The File menu provides the capability to manage configurations and exit the application.   

 

View Menu 

The View menu provides the capability to clear the main window message area and show 

and hide different areas in the main window.   

 

CFDP Menu 

The CFDP menu provides the capability to configure the application, activate and 

deactivate the CFDP service, apply Pause, Resume, Cancel, or Clear to all transactions in 

progress, and Reset Metrics.  Reset Metrics can be used to reset all the metrics to 0 in the 
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metrics log file that is currently open.  The Metrics log file will only be open when 

Metrics Logging is on and the CFDP service is active. 

 

Options Menu 

The Options menu provides access to the Messages dialog, the Configure Message 

Logging dialog, the Configure Statistics Logging dialog, and Reset Statistics.  The 

Messages dialog displays application messages.  The Configure Message Logging dialog 

provides the capability to configure message logging.  The Configure Statistics Logging 

dialog provides the capability to configure statistics logging.  Reset Statistics can be used 

to reset all the statistics to 0 in the statistics log file that is currently open.  The Statistics 

log file will only be open when Statistics Logging is on. 

 

Help Menu 

The Help menu provides access to on-line help and application version information. 

 

 

 

5 Quick Start Guides 

This section provides “How Tos” for common functions. 

5.1 How to Configure the Application 

The following steps describe the minimum necessary to configure the application.  For 

additional information and details about the Configure dialog please reference section 

6.1. 

 

1. Push the Configure button to display the Configure dialog. 

2. Enter your Entity ID in the Local Entity ID field. 

3. Push the + button to create a row to enter Remote Entities information.  For each 

remote entity, enter the Remote Entity ID, the Remote IP Address, and Remote Port.  

You may enter one or more remote entities. 

4. Ensure the CFDP Socket Local IP Address contains a valid local IP address. 

5. Push the OK button to save the configuration information and exit the dialog. 

 

If the application is configured correctly, the Configuration status will be green. 

 

 

5.2 How to Configure Application Defaults 

This section describes how to configure application defaults using the Configure dialog 

Options tab. 

 

1. Push the Configure button to display the Configure dialog. 

2. Go to the Options tab. 
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3. Enter a Default Remote EID.  When you drag and drop files into the “CFDP 

Commands” list or the CFDP Command field, the default Remote EID entered here 

will automatically be used as the Remote EID. 

4. Enter one or more Default Destination Paths.  These paths will be added to the 

Default Destination menu shown on the main window.  The Default Destination 

menu will also contain a "None" item and a "Same As Source" item.  When dragging 

and dropping files, the item selected in the Default Destination menu will determine 

what is placed in the Destination field.  This will work as follows: 

 

 If "None" is selected the Destination field will be blank.  

 If "Same As Source" is selected, the Source information will be copied into the 

Destination field.   

 If a path is selected, and you are dragging and dropping a file, the path selected on 

the Default Destination menu will be copied into the Destination field and 

appended with the Source filename. 

 If a path is selected, and you are dragging and dropping a directory, the path 

selected on the Default Destination menu will be copied into the Destination field. 

 

5. Push the OK button to save the configuration information and exit the dialog. 

 

5.3 Drag and Drop Features 

Drag and Drop is the fastest way to create a list of CFDP commands to transfer one or 

more files and/or directories.  Simply Drag and Drop one or more files from the Directory 

area in the CFDP main window (“CFDP Commands” area) or from an Explorer window.   

 

You can optimize your Drag and Drop experience by setting application defaults such as 

Default Remote EID and Default Destination Paths.  To set these defaults see section 5.2. 

 

5.4 How to Save a CFDP Command List 

A CFDP Command List can be saved by saving the application configuration using the 

File menu’s Save/Save As items or by using the Export List button on the Main Window.  

If the application configuration is saved, the entire application configuration, including 

the CFDP Command List, will be saved in the configuration file.  If the Export List 

button on the Main Window is used, only the CFDP Command List will be saved in the 

file. 

 

The File menu’s Open menu item can only open a TReK CFDP Application 

Configuration file. 

 

The Import List button on the Main Window can only be used to read a CFDP Command 

List file. 
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5.5 How to Start and Stop the CFDP Service 

This section describes how to start and stop the CFDP service.  

 

1. Before the CFDP service can be started, you must configure the application.  To learn 

more about this see section 5.1.  The Configure status must be green before you can 

start the CFDP service. 

2. To start the CFDP service, push the Activate button on the toolbar.  If this is 

successful the Operational status will turn green.  When the Operational status is 

green you can transfer files (send or receive files). 

3. To stop the CFDP service, push the Deactivate button. 

4. When activating or deactivating important status and/or error messages will be 

displayed in the Main Window message area. 

 

5.6 How to Put (Send) a File 

This section describes how to put (send) a file.  

 

1. The CFDP application must be configured and the CFDP service must be active. 

2. Drag and Drop a file into the “CFDP Commands” area. 

3. Ensure the Put, Class of Service, Source, Remote EID and Destination information is 

correct.  The Class of Service should be class1 or class2.  The Source should identify 

the absolute path of the file to be sent.  The Remote EID should identify the target 

Entity.  The Destination should identify where to store the file at the target location.   

4. Push the Execute All button. 

 

Note:  If you want to transfer the contents of a directory, you can enter the absolute path 

for a directory in the Source and Destination fields.  All the files in the first level of the 

directory will be transferred.  Subdirectories will not be transferred.  Be sure to include a 

forward slash ‘/’ at the end of the directory path. 

 

If the text is red, this indicates there is problem with the information provided.  Until this 

is corrected it will not be possible to successfully perform the file transfer. 

 

5.7 How to Get (Retrieve) a File 

This section describes how to get (retrieve) a file.    

 

Special Note:  ISS Change Request (CR) 13351 Ku-Band Forward Access for Payload 

Operations only required support for the “Put” directive.  Therefore, the Get directive is 

not supported in all ISS CFDP implementations.  It is supported by TReK when both the 

sender and receiver are TReK CFDP implementations (TReK CFDP application, TReK 

CFDP console application, or TReK CFDP Library). 

 

1. The CFDP application must be configured and the CFDP service must be active. 

2. Enter information into the “CFDP Commands” area for the file you wish to get.  

Ensure the Get, Class of Service, Source, Remote EID, and Destination information is 
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correct.  The Class of Service should be class1 or class2.  The Source field should 

identify the absolute path of the file to be retrieved from the target entity.  The 

Remote EID should identify the target Entity.  The Destination field should identify 

the location where you want the file to be stored when retrieved.   

3. Push the Execute All button. 

 

Note:  If you want to transfer the contents of a directory, you can enter the absolute path 

for a directory in the Source and Destination fields.  All the files in the first level of the 

directory will be transferred.  Subdirectories will not be transferred.  Be sure to include a 

forward slash ‘/’ at the end of the directory path. 

 

If the text is red, this indicates there is problem with the information provided.  Until this 

is corrected it will not be possible to successfully perform the file transfer. 

 

5.8 How to Monitor File Transfers 

File Transfers can be monitored using the Transactions area in the main window.  No 

transactions will appear until a file transfer is in progress.   Transactions will appear when 

a send or receive is in progress.  The details about the file transfer will stay in the 

Transactions area until they are cleared out. 

 

5.9 How to Configure the Transactions Area 

This section describes how to configure the Transactions area. 

 

1. In the Transactions area, push the Configure button to display the Configure 

Transactions dialog. 

2. To show or hide columns, select the column(s) you would like to show or hide and 

push the arrow buttons to move the columns to the Available list or the Columns 

Showing list as desired. 

3. To order the columns use the Move Up and Move Down buttons to order the list.  The 

top item will be the left most column. 

4. Push the OK button to save the configuration and exit. 

 

The Transactions list can be safely configured while transactions are in progress.  The 

configuration is not saved as part of the application configuration. 

 

5.10 How to Turn on Message Logging 

This section describes how to turn on message logging.  Various types of application 

messages are generated.  As you use the application, messages will be displayed in the 

main window message area and the Messages dialog.  Messages can also be logged to a 

file by turning on Message Logging.  Message Logging will only capture messages 

generated after Message Logging is turned on.  Any messages generated before message 

logging was turned on will not appear in the message log file. 
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1. Go to the Options menu and select ‘Configure Message Logging’. 

2. Check the Log Messages checkbox to turn Message Logging On. 

3. Enter a directory for the Log File in the Log File Path field. 

4. Enter a name for the Log in the Log File Name field. 

5. You can select whether debug messages are written to the Message Log using the Log 

Debug Messages checkbox. 

6. Push OK to save the configuration and exit the Configure Message Logging dialog. 

 

 

5.11 How to Turn on Statistics Logging 

This section describes how to turn on statistics logging. Various types of application 

statistics are generated.  Statistics are generated and captured in memory as you use the 

application.  Statistics can also be logged to a file by turning on Statistics Logging.   

When Statistics Logging is on, the Statistics Log file provides a snapshot of the 

application statistics from the time the application started or the last statistics reset. 

 

1. Go to the Options menu and select ‘Configure Statistics Logging’. 

2. Check the Log Statistics checkbox to turn Statistics Logging On. 

3. Enter a directory for the Log File in the Log File Path field. 

4. Enter a name for the Log in the Log File Name field. 

5. You can select whether packet statistics are written to the Statistics Log using the Log 

Packet Statistics checkbox. 

6. Push OK to save the configuration and exit the Configure Statistics Logging dialog. 

 

 

5.12 How to Turn on Metrics Logging 

This section describes how to turn on metrics logging. Various types of CFDP metrics are 

generated.  Metrics are generated and captured in memory when the CFDP service is 

active.  Metrics can also be logged to a file by turning on Metrics Logging.   The Metrics 

Log file provides a snapshot of the current CFDP metrics starting from the time the 

CFDP service was activated or the last metrics reset. 

 

1. Go to the CFDP menu and select ‘Configure’. 

2. In the Configure dialog select the Options tab. 

3. Check the Log Metrics checkbox to turn Metrics Logging On. 

4. Enter a directory for the Log File in the Log File Path field. 

5. Enter a name for the Log in the Log File Name field. 

6. Push OK to save the configuration and exit the Configure dialog. 

 

 

5.13 How to Use the CFDP Command Line 

This section describes how to access the CFDP Command Line area.   
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Special Note:  ISS Change Request (CR) 13351 Ku-Band Forward Access for Payload 

Operations only required support for the “Put” directive.  Therefore, the Get directive is 

not supported in all ISS CFDP implementations.  It is supported by TReK when both the 

sender and receiver are TReK CFDP implementations (TReK CFDP application, TReK 

CFDP console application, or TReK CFDP Library). 

 

1. Go to the View menu and select File Transfer Command Line. 

2. Set the Default Destination menu if you would like the application to automatically 

fill in the default destination when you drop a file. 

3. Drag and Drop a file or Type a CFDP Command into the CFDP Command field. 

 

The following syntax must be used: 

 

[CFDP Directive] [Class of Service] [source-path] [remote-EID] [destination-path] 

 

You may use put or get for CFDP directive. 

You may use class1 or class2 for Class of Service. 

All paths must be absolute paths. 

 

Example: 

 

put class2 D:\file1.txt 2 C:\myfiles\file1.txt 

 

4. Push the Execute button to execute the CFDP command. 

 

The Clear button can be used to clear the CFDP Command field and the Restore button 

can be used to restore the last command executed. 

 

Note:  If you want to transfer the contents of a directory, you can enter the absolute path 

for a directory in the [source-path] and [destination-path] fields.  All the files in the first 

level of the directory will be transferred.  Subdirectories will not be transferred.  Be sure 

to include a forward slash ‘/’ at the end of the directory path. 

 

 

6 Details 

This section covers various application details. 

6.1 Configuration 

The Configure dialog contains two tabs:  Configuration and Options.  The Configuration 

tab is used to configure parameters that are required and the Options tab is used to 

configure parameters that are optional. 

 

6.1.1 Configuration Tab 

The Configuration tab is shown in Figure 3.  Each field is described below. 
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Figure 3 Configure Dialog (Configuration Tab) 

 

 

Local Entity ID 

This field should contain your Entity ID. 

 

Remote Entities List 

The CFDP application provides the capability to communicate with one or more entities 

when transferring files.  The Remote Entities List identifies the Remote Entity ID, the 

Remote IP Address, and the Remote Port for each remote entity. 

 

CFDP Socket Local IP Address 
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A UDP socket is created to send and receive CFDP packets.  This is the local IP address 

used for the UDP socket. 

 

CFDP Socket Local Port 

A UDP socket is created to send and receive CFDP packets.  This is the local port used 

for the UDP socket. 

 

CFDP Socket Queue Size 

The UDP socket that is created to receive CFDP packets may store CFDP packets in a 

queue prior to the packets being processed by the CFDP library.  This queue minimizes 

the chances of a CFDP packet being dropped due to packet transmission bursts or a 

temporary CPU spike on the receiving platform. In general, a larger queue size is needed 

for higher transmission rates.  If an unacceptable number of CFDP packet retransmissions 

is occurring, increasing the queue size or decreasing the file transfer rate may help 

decrease or eliminate the CFDP packet retransmissions. 

 

Ack Timeout 

The CFDP library sends positive acknowledgment on reception of the end-of-file packet 

and finished packet.  This timeout defines the length of time the CFDP library will wait 

for the Ack packet to arrive prior to retransmitting the end-of-file or finished packet. 

 

Ack Limit 

The Ack Limit is the number of Ack timeouts that may occur prior to cancelling the 

CFDP transaction. 

 

Nak Timeout 

The CFDP library sends a Nak packet identifying the CFDP packets that were not 

received by the CFDP library.  This timeout defines the length of time the CFDP library 

will wait for the retransmission of the requested CFDP packets. 

 

Nak Limit 

The Nak Limit is the number of Nak timeouts that may occur prior to cancelling the 

CFDP transaction. 

 

Inactivity Timeout 

The Inactivity Timeout is the length of time the CFDP library is required to wait between 

CFDP packet receptions prior to cancelling the CFDP transaction. 

 

Outgoing File Chunk Size 

The Outgoing File Chunk Size is the maximum size, in bytes, of the data zone of the 

CFDP packets created by the CFDP library. 
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Aggregate File Transfer Rate 

The Aggregate File Transfer Rate represents the maximum transmission rate, in bits per 

second, of the CFDP packets created by the CFDP library. 

 

Transaction Cycle Time Interval 

The transaction cycle time interval, in milliseconds, controls the processing rate of CFDP 

library transactions.  Minimizing the cycle time, increases the transaction speed or 

processing rate. The default and minimum value is 1 millisecond. This value should only 

be incremented if CPU usage on the host platform is unexpectedly high while idling or 

while processing a transaction. 

 

6.1.2 Options Tab 

The Configuration tab is shown in Figure 4.  Each field is described below. 
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Figure 4 Configure Dialog (Options Tab) 

 

 

Default Remote EID 

The Default Remote EID is used during Drag and Drop.  If this field contains a value, 

this value will be entered as the Remote EID when you drag and drop a file into the 

“CFDP Commands” list or the “CFDP Command” field.   

 

Default Destination Paths 

The Default Destination is used during Drag and Drop.  All destinations listed in the 

Default Destination Paths list will appear in the “Default Destination” menu on the CFDP 

main window.  When you drag and drop a file into the “CFDP Commands” list or the 

“CFDP Command” field, the destination selected from the Default Destination menu will 

automatically be entered into the Destination field.    

 

Log Metrics 
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The CFDP application provides the capability to write metrics to a file.  If you check Log 

Metrics, metrics will be written to the log file specified.  Metrics Logging will start when 

CFDP is activated and stop if you uncheck the box or CFDP is deactivated.  

 

Log File Path 

The Log File Path should contain the absolute path to the directory where the log file 

should be written. 

 

Log File Name 

The Log File Name field should contain the name to use for the log file. 

 

6.2 Transactions 

This section describes the columns in the main window Transactions area. 

 

Transaction ID 

The transaction ID.  A unique ID used to identify a transaction. 

 

Remote EID 

The Entity ID of the other party involved in the transfer. 

 

Status 

The status of the transaction:  Sending, Receiving, Complete, etc.  The Status field 

updates as the transaction progresses. 

 

% Complete 

The % complete of the file transfer.  The % Complete field updates as the transaction 

progresses. 

 

Bytes Transferred 

The number of bytes transferred.  The Bytes Transferred field updates as the transaction 

progresses. 

 

Source  

The source identified in the CFDP command. 

 

Destination 

The destination identified in the CFDP command. 

 

Configuration 

The configuration field indicates the direction of the file transfer: “Sending” or 

“Receiving”. 

 

File Size 

The File Size field displays the size of the file being transferred in bytes.   
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6.3 Statistics 

This section describes the statistics that can be logged by the application to a user 

specified file.  Statistics include device statistics and packet statistics.  The snapshot of 

device and packet statistics is updated once a second with current statistics information at 

both the device and packet level.  Device statistics provides information on all packets 

that are being received or sent by the device.  Packet statistics provides information on 

the individual packet groups that are being received or sent by the device. The TReK 

CFDP library that performs this work for the application does not divide packets into 

groups so packet statistics mirror device statistics.  

 

Device Statistics 

 

Device Key 

A character string that uniquely identifies each device. 

 

IP Address 

The IP address of the device if it is a socket. 

 

Port (C/L/S) 

The port number of the device if it is a socket.  If the socket is a client socket then the 

port number will be followed by two ‘/’.  If the client socket is connected to a listener 

socket, the listener’s port number is also listed.  If the socket is a server socket then the 

client port number that is connected to the server is listed first, followed by two ‘/’ and 

the server’s listener port number.  If the socket is a listener socket the listener’s port 

number is listed between two ‘/’. 

 

Protocol 

The IP transportation protocol, either TCP or UDP, if the device is a socket. 

 

Segments Rcvd 

The number of segments received by the device if the device is a TCP socket. 

 

Pkts Rcvd 

The total number of packets received by the device. 

 

Pkts Sent 

The total number of packets sent by the device. 

 

Pkt Rcv Rate 

The number of packets received by the device in the last second. 

 

Max Pkt Rcv Rate 

The maximum packet receive rate experienced by the device. 
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Kbit Rcv Rate 

The kilobits received by the device in the last second. 

 

Max Kbit Rcv Rate 

The maximum kilobit receive rate experienced by the device. 

 

Pkt Send Rate 

The number of packets sent by the device in the last second. 

 

Max Pkt Send Rate 

The maximum packet send rate experienced by the device. 

 

Kbit Send Rate 

The kilobits sent by the device in the last second. 

 

Max Kbit Send Rate 

The maximum kilobit send rate experienced by the device. 

 

Pkts Dropped 

The total number of packets that were dropped because they could not be temporarily 

stored in a queue or buffer.  The most likely cause of dropped packets is packets arriving 

at very high packet rates and/or a queue size that is too small. 

 

 

Packet Statistics 

 

Packet Key 

A character string that uniquely identifies each packet type. 

 

Pkts Rcvd 

The total number of packets that are received and identified as this packet type. 

 

Pkts Sent 

The total number of packets that are sent and identified as this packet type. 

 

Pkt Rcv Rate 

The number of packets received and identified as this packet type in the last second. 

 

Max Pkt Rcv Rate 

The maximum packet receive rate experienced by this packet type. 

 

Kbit Rcv Rate 

The kilobits received and identified as this packet type in the last second. 

 

Max Kbit Rcv Rate  
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The maximum kilobit receive rate experienced by this packet type. 

 

Pkt Send Rate 

The number of packets sent and identified as this packet type in the last second. 

 

Max Pkt Send Rate 

The maximum packet send rate experienced by this packet type. 

 

Kbit Send Rate 

The kilobits sent and identified as this packet type in the last second. 

 

Max Kbit Send Rate 

The maximum kilobit send rate experienced by this packet type. 

 

Pkts Dropped 

The total number of packets, of this type, that were dropped because they could not be 

processed by another device.  The most likely cause of dropped packets is packets 

arriving at very high packet rates. 

 

Pkt Seq Errors 

The total number of packet sequence errors identified for this packet type. For example, 

the primary header of the CCSDS packet contains a 14-bit number that is used as a 

sequence count. For each packet that arrives, the sequence count is compared to 

the sequence count of the previous packet. If the count is not the next in the sequence, the 

packet sequence error value is incremented.   

 

Max Pkt Seq Error 

The maximum packet sequence error experienced by this packet type. 

 

 

6.4 Metrics 

This section describes the CFDP metrics that can be logged by the application.  The 

snapshot of CFDP metrics is updated once a second with the completion status of each 

CFDP transaction.  The CFDP metrics are divided into sending and receiving categories 

and grouped by file size ranging from less than a one megabyte to over a gigabyte.  The 

metrics include calculations on the number and percent of files sent or received, the 

minimum, maximum, and average file transfer time, and the number and percent of files 

that required packet retransmission. 

 

The following Metrics are provided for Sending and Receiving. 

 

File Size (MB) 

The minimum and maximum file size, in megabytes, for the group. 

 

Success Count 
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The number of successful file transfers for the group. 

 

Success % 

The percentage of successful file transfers for the group. 

 

Cancel Count 

The number of canceled file transfers for the group. 

 

Abandon Count 

The number of abandoned file transfers for the group. 

 

Fail Count 

The number of failed file transfers for the group. 

 

Unknown Count 

The number of unknown file transfers for the group. 

 

Min Trans Time (sec) 

The minimum successful file transfer time in seconds. 

 

Max Trans Time (sec)  

The maximum successful file transfer time in seconds. 

 

Avg Trans Time (sec) 

The average successful file transfer time in seconds. 

 

Success W/NAK Cnt 

The number of successful file transfers that required one or more NAK packets. 

 

Success W/ NAK % 

The percentage of successful file transfers that required one or more NAK packets. 

 

Min NAK Cnt/Trans 

The minimum number of NAK packets that had to be transferred for a successful file 

transfer requiring NAK packets. 

 

Max NAK Cnt/Trans 

The maximum number of NAK packets that had to be transferred for a successful file 

transfer requiring NAK packets. 

 

Avg NAK Cnt/Trans 

The average number of NAK packets that had to be transferred for a successful file 

transfer requiring NAK packets. 

 



TREK-USER-0003 

 21 

6.5 Configure Message Logging 

This section describes how to configure message logging.  The Configure Message 

Logging dialog is shown in Figure 5.  This dialog can be displayed using the Options 

menu Configure Message Logging menu item. 

 

 

Figure 5 Configure Message Logging Dialog 

 

Each field is described below. 

 

Log Messages 

The CFDP application provides the capability to write application messages to a file.  If 

you check Log Messages, application messages will be written to the log file specified.  

Logging will start once it is turned on, so any messages generated before logging was 

turned on will not appear in the file. 

 

Log File Path 

The Log File Path should contain the absolute path to the directory where the log file 

should be written. 

 

Log File Name 

The Log File Name field should contain the name to use for the log file. 

 

Log Debug Messages 

The Log Debug Messages checkbox specifies whether debug messages should be written 

to the log.  For example, if Debug is checked, Debug messages will be written to the log. 

 

 

6.6 Configure Statistics Logging 

This section describes how to configure statistics logging.  The Configure Statistics 

Logging dialog is shown in Figure 6.  This dialog can be displayed using the Options 

menu Configure Statistics Logging menu item.  Statistics are generated and captured in 

memory as you use the application.  Statistics can also be logged to a file by turning on 

Statistics Logging.   When Statistics Logging is on, the Statistics Log file provides a 
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snapshot of the application statistics from the time the application started or the last 

statistics reset. 

 

 

Figure 6 Configure Statistics Logging Dialog 

 

Each field is described below. 

 

Log Statistics 

The CFDP application provides the capability to write application statistics to a file.  If 

you check Log Statistics, application statistics will be written to the log file specified. 

 

Log File Path 

The Log File Path should contain the absolute path to the directory where the log file 

should be written. 

 

Log File Name 

The Log File Name field should contain the name to use for the log file. 

 

Log Packet Statistics 

The Log Packet Statistics checkbox specifies whether packet statistics should be written 

to the log.  For example, if Packet is checked, packet statistics will be written to the log. 

 

6.7 Application Messages 

Various types of application messages are generated including information, progress, 

warning, error, and debug messages.  Information, warning, and error messages will be 

displayed in the main window message area.  All application messages are sent to the 

Messages dialog shown in Figure 7.  The Messages dialog can be configured to display 

specific types of messages.  By default, the Messages dialog will display information, 

progress, warning, and error messages.  Columns in the Messages dialog can be sorted by 

clicking on the column header.  The Messages dialog is available from the Options menu.   
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Figure 7 Messages Dialog 

 

Configure 

The Configure button provides access to the Configure Messages dialog shown in Figure 

8.  This dialog is used to filter the types of messages (category) displayed in the 

Messages dialog. 

 

 

Figure 8 Configure Messages Dialog 

 

 

Clear 

The Clear button provides access to the Clear Messages dialog shown in Figure 9.  This 

dialog provides two ways to clear messages in the Messages dialog.  You can clear all the 

messages or clear selected messages.  Once you clear messages, the messages are 

permanently deleted.   

 

 

Figure 9 Clear Messages Dialog 
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Export 

The Export button provides the capability to save all the application messages to a file.  

When you push the Export button you will be prompted for a directory and filename.  

Export will save all messages, not just the messages currently displayed in the Messages 

dialog (i.e. the ‘Configure’ filter is not applied).  The name you provide for the file will 

be modified with a time tag prefixed to the filename.  The time tag indicates the time the 

file was closed.  For example: 

 

Filename Input:   messages.txt 

Filename Output: GMT_2014-04-10_16~57~27~182_messages.txt. 

 

 

6.8 Application Configuration File 

The CFDP application saves the following information when you save a configuration:   

 

 Configuration information in the Configuration Dialog. 

 CFDP Commands list displayed in the Main Window CFDP Commands area. 

 CFDP Command displayed in the Main Window File Transfer Command Line. 

 Default Destination menu selection in the CFDP Commands area. 

 Default Destination menu selection in the File Transfer Command Line area. 

 Log Messages Configuration 

 Log Statistics Configuration 

 Configure Messages Checkbox Selections 

 

The configuration of the Transactions area (columns showing/column order) is not saved. 

 

6.9 Application Settings 

The CFDP application saves some settings as application settings each time you exit the 

application.  The next time you run the application, the application will initialize with the 

previous application settings.  The following application settings are saved: 

 

 Application Window Size 

 Application Window Position 

 

7 FAQ and Troubleshooting 

This section addresses Frequently Asked Questions and provides tips for troubleshooting 

common gotchas. 

 

7.1 Is There an Easy Way to Transfer the Contents of a Directory? 

Yes.  To transfer the contents of a directory, enter the absolute path to the directory.  The 

CFDP application will transfer all the files in the first level of the directory.  
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Subdirectories will not be transferred.  Be sure to include a forward slash ‘/’ at the end of 

the directory path when entering the absolute path into the Source and Destination fields. 

 

7.2 What is class1 and class2? 

Note:  Special thanks to NASA/GSFC/Tim Ray for the following user friendly 

definitions: 

 

“CFDP provides three Service Classes.  Service Class 1 simply sends each file; there are 

no replies from the receiver, nor is there any guarantee of reliable delivery.  Service 

Class 2 ensures reliable file delivery; any required retransmissions are requested and 

performed by CFDP.  Service Class 3 provides Proxy Operations (e.g. Entity ‘A’ tells 

Entity ‘B’ to make a request of Entity ‘C’).” 

 

The TReK CFDP application supports Class 1 and Class 2.  When typing in one of these 

choices please use class1 and class2. 

 

7.3 Source and Destination Constraints 

Source and Destinations must be identified using an absolute path.  The absolute path 

name consists of the full path and the file name. The absolute path must meet the 

following criteria: 

 

 The absolute path must not contain spaces. 

 The absolute path cannot exceed 256 characters (null terminated). 

 The size of the file to be transferred must be greater than 0 Bytes. 

 The size of the file to be transferred cannot exceed 2.1 Giga Bytes. 

 

7.4 I Dropped My File into the List and it Turned Red 

Red indicates the file or directory contains an illegal character.  File and directory names 

must meet the File and Directory Name Constraints described in section 7.1. 

 

7.5 My File Starts to Transfer and Then Stops 

Chances are the remote entity is unavailable or is not configured as you expected.  Check 

both the Local and Remote entity configurations and ensure the EIDs are correct, the IP 

address and port information is correct, and both entities are up and running.  

 

7.6 Transfer Results When Item Exists At Destination 

If you attempt to transfer an item to a destination on a Windows computer, and the item 

already exists at the destination, you will see a “cancelled (Filestore rejection)” error 

message and the item will not be overwritten.  If you attempt to transfer an item to a 

destination on a Linux computer, and the item already exists at the destination, the item 

will be overwritten. 
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7.7 Important Things To Know When Using The Get Primitive 

The TReK CFDP software provides the capability to "get" or retrieve one or more files 

from a remote destination.  It is important to note that the CFDP Blue Book describes 

implementation of a "get" as a proxy "put".  TReK does not implement a CFDP Blue 

Book defined proxy "put" function.  Therefore, the "get" request will only succeed if both 

sides of the file delivery transaction are using TReK software.  The TReK get function 

initiates the file transfer process by delivering an equivalent "put" primitive character 

string to the remote platform's CFDP software.  There are some error scenarios in which 

the initiator of the “get” receives no feedback.  Some examples are:  

 

 The get request never reaches the remote platform. 

 The requested file(s) do not exist on the remote platform in the location specified in 

the get request. 

 

If the “get” request reaches the remote platform, the remote platform log file may contain 

status information regarding the request. 

7.8 How Does Pause Transactions Work? 

CFDP pauses transactions by pausing both data transmission and timeout clocks 

associated with the local platform’s file transfer transactions.  The remote platform is not 

notified of the pause of file transfer transactions on the local platform and may exceed its 

timeout limits if the local platform does not resume its file transfer transactions for an 

extended period of time.  If the local file transfer pause is for an extended period of time, 

the remote platforms should receive a separate pause transaction command to avoid 

exceeding its timeout limits.  Both platforms may resume file transfer transactions when 

they receive separate resume file transfer transaction commands. 

 

 


